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The QuNexus Editor is a free application that we provide on our website. It allows you to create 
customized Presets and load them onto QuNexus. This chapter will guide you through 
everything you need to know to acquire and operate the QuNexus Editor.

System Requirements

We recommend the following minimum system requirements for the QuNexus Editor:

MAC:
● An Intel Core 2 Duo 2.3GHz or 

greater
● Mac OS 10.5 or later
● 50MB free hard disk space

WINDOWS:
● Windows XP, or Windows 7
● Intel Core 2 processor or greater
● 1GB of RAM with 50MB free hard disk 

space

Installing the Software
For those who wish to customize QuNexus, download our free QuNexus Editor Installer from: 
http://www.keithmcmillen.com/QuNexus/downloads/. This comes with the QuNexus Editor and 
Documentation.

Installer Instructions (Mac and Windows XP & 7)
1. Double-click on the .dmg file to open the disk image, and then double-click on the 

QuNexus Editor Installer.
2. Type the admin password for your computer and click ok (Mac). Then click next.
3. Either choose a new directory where QuNexus will be installed or accept the default 

directory. Click next.
4. Name the installation folder or accept the default. Click next.
5. Finish up with the installer and a QuNexus folder will now appear in the Applications 

(Mac) or C: drive (Windows) directory on your computer (or wherever you chose to 
install it).
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Updating the Firmware

Make sure the editor and the firmware versions are compatible with each other.

When the QuNexus Editor opens, it checks to make sure the 
firmware on the device is compatible with the application. If the 
firmware is not compatible, an update prompt will appear. Click 
ok and wait until the blue Shift button light stops flashing. The 
blue light and progress bar on screen indicate that the 
firmware update is in progress.

An “Update Firmware” option is located in the Hardware Menu of the QuNexus Editor. Select 
this option to force a firmware update.

Keith McMillen Instruments cannot be held liable for damage resulting from installation 
and operation errors or improper use.

2



Main Window Overview

The QuNexus Editor opens with this window:

Customize the QuNexus output and input using the Keyboard, Controller, and CV tabs (Layers).

Just above the right side of the tabbed box are the global sensitivity settings to control Gain, On 
Threshold, Off Threshold, and Tilt Sensitivity for the QuNexus keys. Controls for saving and 
recalling presets are found on the right side of the window. There are tabs for editing Keyboard 
Layer, Controller Layer, and CV Layer. Keyboard Layer is the main space for editing the 
behavior of the keyboard. Controller Layer allows you to assign additional Notes and individual 
Pressure and Tilt CC#s for each Key. CV Layer is for editing the CV input and output.
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Saving Presets

Select presets by clicking on them in the Library. There are four 
Factory Presets (see the Factory Presets chapter of the QuNexus 
Full Manual for descriptions of each one).

After clicking a Preset, the name of it will appear above the tabs. 
Now you can make changes to the Preset. The Preset name will 
turn red and an asterisk will appear next to it to indicate it has 
unsaved changes. You can use the Revert button or the Save 
button under the Preset Library to discard or keep your changes. 
The Revert button will go back to the previously saved version of 
the preset.

The Delete and Save As buttons under the Preset Library allow 
you to add or remove presets. Copy/Add a Preset by first 
selecting the preset you wish to copy and then clicking the Save 
As button. You can name it and it will be added to the bottom of 
the Library.

To send any of the Presets in the Library down to the QuNexus, 
click on the Preset in the Library and use the buttons in the Send 
box (shown to the right) to send it to any of the four Preset slots. If  
the Preset has any unsaved changes you must save them before 
sending them to the QuNexus. The Library will display which 
Presets are in which slots on the QuNexus.

For information about how to select presets on the QuNexus see the Selecting Presets chapter 
of the QuNexus Full Manual.

Importing and Exporting Presets

Import and Export Presets using the commands in the File Menu. 
Import Preset lets you select a previously exported preset and load 
it to the currently selected preset slot. You must save the preset 
after importing it in order to keep it. Export Preset will save a file 
containing the currently selected preset to a location of your choice 
on your hard drive for safe keeping or sharing. Importing and 
Exporting makes preset sharing easy.
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Menu Bar

The QuNexus Editor’s Menu Bar contains several useful features.
The File menu duplicates the New, Save, Delete, and 
Revert Preset functions from the Preset Library box, 
assigning them shortcuts to add convenience.

You can also Revert or Import Factory Presets.

Revert Preset to Factory causes the currently preset 
parameters to change to the Factory Preset selected from 
the menu. The name will not change.

Import Factory Preset will create a new slot with the 
original Factory Preset.

See the Importing and Exporting Presets chapter for more 
information about the other File menu items.

The Edit menu contains several copy/paste functions. In 
Controller Layer you can highlight a key, copy it by going to 
Copy Controller Sensor, highlight another key, and paste 
by going to Paste Controller Sensor.

You can also use the items within the Copy/Paste Layer 
submenu to copy and paste entire layers to other Presets. 
Select a Preset and use the menu options to copy its 
Controller Layer, Keyboard Layer, or CV Layer. Then go to 
a different Preset and paste the corresponding Layer.

The Hardware menu includes an option to force a Firmware 
update. If the connected QuNexus’ firmware is already up 
to date it will just re-upload the same firmware. If not the 
QuNexus should automatically prompt you for an update 
when you open the Editor.

Here you can also select an LED Refresh Mode:

Normal - LEDs behave normally, lighting up and responding to Remote LED messages as 
expected.

Control Only - Only the LEDs on the Side Buttons will light up. The Keyboard LEDs will not 
light when touched or respond to Remote LED Control. LEDs will still light up normally in Preset 
Select and Live Edit Modes.

All Off - None of the LEDs will light. The Keyboard LEDs will not respond to Remote LED 
Control. LEDs will still light up normally in Preset Select and Live Edit Modes.
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Sensitivity

There are Sensitivity controls just above the tabs. Here you can adjust the Sensitivity, On and 
Off Thresholds, and the Tilt Sensitivity. These are global for the entire keyboard but can be set 
differently for each preset.

Sensitivity controls how easy it is to get higher value ranges when controlling pressure and 
velocity. The higher the sensitivity, the easier it will be to reach the upper range of values. The 
lower the sensitivity, the more difficult or impossible it will be to get higher value ranges. 

On Thresh controls the pressure value at which a note on will register. Example: If set to 10, the 
Slider pressure has to reach a value of 10 before a note on is sent.

Off Thresh controls the pressure value at which a note off will register. Example: If set to 5, the 
Slider pressure would have to be 5 or lower for a note off to register. This cannot be set higher 
than the on threshold.

Tilt Sens. controls how easy it is to activate the Tilt source. By default, Tilt requires an 
intentional pressure shift/tilt of your finger to engage. This makes it easier to activate Tilt only 
when you want to. The higher the value of Tilt Sens., the easier it is to activate Tilt.
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Keyboard Layer

Here you can choose how the QuNexus keys output MIDI. Start with what type of MIDI data you 
want, go across the row, and end with the output destination (USB, Expander, or USB + 
Expander). For example, if you want to add Pitch Bend to your keyboard follow these steps:

1. Find Pitch Bend in the first column.
2. Go across the row and select the desired source in the second column (how about tilt?).
3. Use the math modifications if you wish to, or leave them the same if you don’t wish to 

alter the MIDI output with math.
4. Select what MIDI output you wish to use in the final column (USB, the MIDI Expander, or 

both).

The following subchapters will go into detail for each column one at a time:

Types

Note: This type is the note velocity that each key will use to output with the Note. Velocity 
simulates the way a piano gets louder as the keys are struck with greater force. So the higher 
the velocity values (0-127) are, the louder the MIDI notes will sound. This type is set to always 
use Key Velocity as the source.
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Pitch Bend: Each note can bend its pitch using this type. Pitch bend is currently 7 bit. The bend 
range in part depends on the MIDI device used for output but is also settable on our end using 
the Bend Range box. 

Channel Pressure: The Channel Pressure message is for sending a continuous pressure value 
(from 0-127) for the entire keyboard (an average of the pressure of all keys on one channel). 
Not all MIDI devices can interpret Channel Pressure so make sure to check the device or 
software you are working with.

Poly After Touch: This is for sending a continuous pressure value (from 0-127) after a note on 
for each key individually.

CCs: Stands for Continuous Controller. There are 4 rows to allow the use of 4 different CC 
numbers. This MIDI format contains a controller number and a 7 bit value (0-127). It is often 
used to control miscellaneous parameters like distortion amount or the volume of a mixer 
channel.

Sources

Key Velocity (for notes only): The value between 0 and 127 that represents the overall 
pressure on the QuNexus keys at the moment a note on (or finger on) is detected. Sensitivity 
can be adjusted using the Sensitivity number box above the tabbed box.

Pressure: Continuous values (between 0 and 127) represent the applied pressure of your finger 
on the QuNexus keys.

Tilt: Continuous values (between 0 and 127) represent the tilt of your finger on the QuNexus 
keys. When released the value goes back to center (63). By default, Tilt requires an intentional 
pressure shift/tilt of your finger to engage. This makes it easier to activate Tilt only when you 
want to. You can increase the sensitivity of the tilt activation pressure by increasing the value in 
the Tilt Sens. number box above the tabbed box.

Expression Pedal: When an expression pedal is plugged into the CV input of QuNexus, the 
expression pedal data will be converted to MIDI and go from 0 - 127. When Channel Rotation is 
enabled the Expression pedal sends out on all active Channels. If no keys are held down it will 
send out on the main starting Channel. 
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Gain, Offset, Curve, Min, and Max

After selecting your source for the MIDI data type, you can then further modify what values you 
are sending to your MIDI device/software by using the math modifiers in the next five columns.

Gain: The number in the gain box is used to multiply the raw value coming from the source. For 
example, setting the gain number box to “2” will double whatever value is received from the 
source. Setting the gain box to 0.5 will cut the value from the source in half.

Offset: The offset is added onto the raw value after it has been multiplied by the gain value.

Curve: The result after the offset is entered into the selected curve’s lookup table and used to 
plot the index on a chart. There are a number of table options, each which will affect the value 
differently as it increases or decreases. The shape of each curve is pictured below:

Min and Max: These allow the value to be constrained between a minimum and a maximum 
number. If the min is set to 10 and the max is set to 15, then the output cannot be less than 10 
or more than 15. Anything outside the range of the min and max will be truncated. Note offs will 
still be at velocity 0 even if the min is set above 0.

Example: If I want Channel Pressure to control a Filter cutoff but only span half the range of the 
filter I could do this two different ways:

1. Set the Channel Pressure Gain to .5 so that you only get half the values. If you wanted 
to get the top half of the filter you could set the offset to 63. This would allow you to 
output a pressure of 63-127 to the filter.

2. Set Min to 63 and keep Max to 127. This allows an output of 63-127.

While both methods work and set the same range of output values, the first method is probably 
a better way to achieve these results. This is because the second method ignores and truncates 
the first half of the pressure of your finger on the key. The first method scales the range so that 
the whole range of motion is used.
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Out
The possible output destinations for the MIDI data results are:

USB: MIDI goes from the QuNexus keyboard to an attached computer through USB Port 1.

Expander: If a KMI MIDI Expander is attached, the MIDI data will go out the Expander’s 5-pin 
MIDI Out port.

USB + Expander: MIDI data goes out the KMI MIDI Expander’s 5-pin MIDI Out port and to a 
computer through USB port 1.

MIDI Channel
Set the output channels In the MIDI Channel box in the bottom left corner. There 
can be separate USB and MIDI Expander Channels. If Channel Rotation is on 
then the Channels set in this box act as the starting channel (see the Channel 
Rotation chapter for more information).

It is also possible to change your MIDI Channel on the fly using Live Edit Mode. 
See the Live Edit Mode Manual for more information.

Channel Rotation

Channel Rotation is a feature that causes the order of keys pressed at one time to rotate 
through channels. For example, the first pressed key’s MIDI data from Keyboard Layer goes out 
Channel 1, the second pressed key’s data goes out Channel 2, the third pressed key’s data 
goes out Channel 3, etc. Release those keys and you will start over on Channel 1 next time you 
press a key. This feature is useful for getting a different pitch bend, channel pressure, or poly 
aftertouch for each note as opposed to one for all notes.
The polyphony number sets how many channels/keys can be used at one time. 
Adjust the MIDI Channel to change the starting channel. 

Both the polyphony number and the MIDI Channel can be changed on the fly 
using Live Edit Mode. See the Live Edit Mode Manual for more information.
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Toggle

The Toggle box includes a menu to select between Normal, Legato, and Toggle 
modes. Below are descriptions of each mode:

Normal - Pressing a key sends a note on, releasing the key sends a note off.

Legato - Pressing a key sends a "note on" but releasing doesn’t send a note off. When a 
different key is pressed, the previous note is turned off and the new note is turned on. Tap the 
Togl A button on the left side of the QuNexus to clear a note without having to hit the next one.

Toggle - Pressing a key sends a note on, a second press on the same key turns that note off. 
Pressing a different key sends a note on without turning off the previous key. Tap the Togl A 
button on the left side of the QuNexus to clear all notes. The LEDs will display which keys are 
“on”.

Presets will always start in Normal Mode. Hold the Togl A button for approximately 1 second to 
turn the selected Toggle mode on. Depending on the settings of your preset, the Toggle On 
state will either use Toggle or Legato.

Transpose

The Transpose value represents the number of semitones to transpose the 
keyboard up or down.

The Transpose value can also be changed on the fly using Live Edit Mode. See 
the Live Edit Mode Manual for more information.

LEDs Local/Remote

The LED Mode box allows you to turn off Local LED Control. Local LED Control is 
the QuNexus’ built-in LED behavior. Without sending LED messages to the 
QuNexus from another application or device, the QuNexus’ LEDs will 
automatically respond to touch.

There is also a number box for selecting which MIDI Channel the LEDs respond to when 
sending Remote LED Control Notes to the QuNexus on USB Port 1.

Remote LED Control is always allowed but if Local LED Control is enabled, the LEDs will 
prioritize the Local LED Behavior. So if you’ve sent a Remote LED Note on message to a key 
and then touch and release the same key, the LED will turn off. This is because when you 
released the Note the Local LED behavior turns the LED off. 

See the Controlling LEDs chapter of the QuNexus Full Manual for more information about 
Remote LED Control.
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Program Change

Here you can set the Preset to use a Program Change Message. This will 
cause the QuNexus to output the Program Change value every time that 
preset is selected from the QuNexus. See the Selecting Presets chapter of the 
QuNexus Full Manual for more information. Program Changes can be useful 
for changing presets on a synth.

Bend Range

Here you can set the Range of semitones for Pitch Bend. This should alter the 
Min and Max setting of the Pitch Bend line above.

The Bend value can also be changed on the fly using Live Edit Mode. See the Live Edit Mode 
Manual for more information.

Key Priority

This selection box assigns which keys pressed will have control over the tilt, 
channel pressure, poly aftertouch, and other sources of Keyboard Layer. The 
options are Latest, Earliest, Highest, and Lowest. Whichever option is selected 
indicates the key that will have the control. For example: if “Latest” is selected, 
the last key pressed will have control over Pitch Bend if Pitch Bend is set to Tilt 
(or Pressure).
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Controller Layer

The Controller Layer tab appears next to Keyboard Layer. Here you can assign each key its 
own additional Note, Pressure CC#, and Tilt CC#. Do this by clicking on any key in the image so 
that it is highlighted with a green border. Then look below the image at the Sensor Settings.

Sensor Settings

Here you can start by deciding what to enable for the highlighted Key. There are two enable 
checkboxes, one for Keyboard Layer and one for Controller Layer:

If you disable Keyboard Layer, it will no longer play its regular note or contribute to controlling 
Channel Pressure, Poly After Touch or anything else that might have been set up in the 
Keyboard Layer tab. Local LED behavior will also turn off for that key, meaning it will not light up 
when pressed (it can still receive Remote LED messages though). The Octave buttons will no 
longer do anything since they only raise and lower the octave of the notes in Keyboard Layer.

If Controller Layer is disabled, nothing you do here will have an effect on that Key. Enabling it 
allows you to assign it a second Note or its own Pressure and Tilt CC numbers. Setting the 
number box to “-1” can turn any of these three sources off.

If both Keyboard Layer and Controller Layer are enabled, the key will send out everything 
that you have assigned it. For Example: if you turn Channel Pressure on and Pitch Bend set to 
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Tilt in Keyboard Layer and have all 3 sources on in Controller Layer, then that Key will send out 
2 notes, Channel Pressure, Pitch Bend, and CC values for an additional Pressure and Tilt 
source. Controller Layer assignments will not increment or decrement when using the -Oct+ 
buttons. Neither will they Rotate Channels if Channel Rotation is enabled in Keyboard Layer.

CV Layer does not convert MIDI Messages from Controller Layer.

CV Layer

Here you can choose how the QuNexus keys send and receive CV (Control Voltage). QuNexus 
has 4 possible CV outputs and 2 possible CV inputs (see the CV Manual for the hardware 
specs).

There is a box labeled Gate Legato in the upper right corner; if this is checked, the gate output 
will not iterate an off state between notes.

You can set the Pitch Scaling Scheme in the top right corner. You can set this to 1 Volt per 
Octave, 1.2 Volts per Octave, or Hertz per Volt (an older scaling scheme).
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CV Output (MIDI to CV)

The MIDI to CV table has 4 rows (1 for each CV output) and 9 columns. Start with what MIDI 
Device Input you are using, go across the row, and end with the CV output destination (Gate, 
CV 1, CV 2, or CV 3). For example, if you want Pitch Bend Data from the MIDI Expander to go 
out CV 1 follow these steps:

1. Locate the Row used for CV 1 (second row).
2. Select Expander as the MIDI Device Input.
3. Choose the MIDI Channel whose Pitch Bend data you wish to use.
4. Select Pitch Bend as the MIDI Type in column 3.
5. Use the math modifications if you wish to, or leave them the same if you don’t wish to 

alter the data output with math.

Tip: The Channel parameter here in CV Layer is used only for messages coming from the USB 
Ports, not the keyboard itself. The CV outputs will use MIDI notes from Keyboard Layer 
regardless of the Channel. Whatever the Key Priority in Keyboard Layer is set to will be the note 
that CV sends out (see the Key Priority chapter for more information).

CV Input (CV to MIDI)

The CV to MIDI table has 2 rows (1 for each CV output) and 9 columns. Start with what CV 
input you are using, go across the row, and end with the MIDI Device the converted MIDI Data 
will be sent to (Expander, USB 3, or USB 3 + Expander). For example, if you want to convert an 
Expression Pedal to control CC# 7 on Channel 1 for a device connected to the MIDI Expander 
follow these steps:

1. Choose the row for CV 1 or CV 2.
2. Select the MIDI Channel to convert the CV to.
3. Select the CC # to convert the CV to.
4. Use the math modifications if you wish to, or leave them the same if you don’t wish to 

alter the MIDI output with math.
5. Select which MIDI device to output the data to (MIDI Expander, USB 3, or USB 3 + 

Expander).
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